
 

Objectives 
 

This unit builds on the previous Quick Start to Excel by introducing the more advanced con-
cepts which are applicable to using Excel in a commercial context. 

The objective of this unit is to enable you to:  

• Make use of the data entry tools: AutoFill, AutoComplete, AutoCorrect, Undo. 

• Apply advanced cell formatting: text alignment, AutoFormat, automatic formatting, condi-
tional formatting and more advanced number formats. 

• Use the following built-in functions: sum, average, count, max, min, var, stdv, median, 
round, int, abs, ceiling, floor, rand, choose, vlookup, hlookup, now. 

• Know how and when to use absolute, relative and mixed cell references. 

• Assign and use range names. 

• Understand the basics of Excel’s date and time arithmetic. 

• Know how to work with larger spreadsheets, including window zoom, full screen mode, 
collapse buttons and split windows. 

• Use the values in a spreadsheet to generate a chart and customize the chart. 

• Use the grouping feature and data filter feature to assist the viewing of larger data sets. 

• Use pivot tables for simple data mining. 

• Describe how to construct a good spreadsheet. 
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Efficient Data Entry 
You will spend quite a bit of time entering data in the spreadsheet. Excel has tried to make 
things as easy as possible for you by including “intelligent” data entry tools: AutoFill,  Auto-
Complete, AutoFormat and AutoCorrect.  

Using AutoFill 

Copying the contents of a cell or range to adjacent cells. 
You can use the clipboard copy and paste functions from the Edit menu or the standard 
toolbar to copy data from one cell or range to any other cell or range. However, if you want 
to copy (or repeat) the contents of a cell into adjacent cells, follow these steps. 

1. Click the cell (to make it the current cell). Alternatively, you can select an entire range 
if you wish to copy the contents of more than one cell. 

2. Move the mouse cursor over the handle on the bottom right corner. The cursor will 
turn from a white cross  into black cross Ë . 

3. Drag the cursor vertically or horizontally along as many adjacent cells as you wish to 
copy the data to. 

Using AutoFill for common data series. 
Excel makes intelligent use of the above procedure to save you from the tedious job of hav-
ing to type in frequently used data series. 

• If a cell contains the text Mon, dragging the cell handle will automatically fill the adjacent 
cells with Tue, Wed, Thu, Fri etc. Similarly, Monday will be “extended” into Tuesday, 
Wednesday, Thursday etc. 

• If a cell contains the text Jan (or January), AutoFill will complete the sequence of  the 
months Feb, Mar, Apr … for you if you drag the cell handle across adjacent cells. 

• Similarly, 1st will be extended into 2nd, 3rd etc. 

• AutoFill will even handle an entry like Product1 and modify it to become Product2, 
Product3 etc. 

• If a cell contains any other value that Excel doesn't recognise as part of a standard se-
quence, it will just copy the value (label or number). 

Note: if you wish to create a number series which increases by 1 from cell to cell, you can 
use a modified version of the AutoFill command: just hold down the <Ctrl>-key while drag-
ging the cell handle. 
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Using AutoFill to enter a linear series of data. 
AutoFill can also be used to enter a series of (linearly) increasing or decreasing data. As-
sume that you wish to enter the following series in a column: 2, 4, 6, 8, 10 … up to 50.  Use 
AutoFill in the following way to make your work a lot easier. 

1. Enter the number 2 in the first cell of the column. 

2. Enter the number 4 in the second cell of the column. 

3. Highlight (select) both these first two cells of the column with your mouse cursor. 

4. Move the mouse cursor to the (bottom right) cell (range) handle and drag it vertically 
down the column. As you drag the handle across the cells, you will see AutoFill’s 
suggested values appearing: 6, 8, 10 etc. Keep dragging down until you reach your 
desired final value (e.g. 50). 

AutoFill can handle a wide variety of series, including dates. The following are some exam-
ples of series that are completed if you enter their first two (cell) values. 

• 3-Mar, 10-Mar è 17-Mar, 24-Mar, 31-Mar, 7-Apr …  

• Jan, Mar è May, Jul, Sep, Nov …  

• 0, 10 è 20, 30, 40 … 

• 6, 4 è 2, 0, -2, -4, -6 … 

• Product 1, Order è Product 2, Order, Product 3, Order, Product 4, … 

AutoFill can be used for even more advanced series.  Check Excel Help for detailed instruc-
tions on how to use the following features. 

• It can extrapolate a linear trend from numbers that are not exactly evenly spaced:  
e.g. 1, 2, 4 è 5.33333, 6.83333, 8.33333, 9.83333 … 
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• It can be configured to complete series by multiplying with a constant (instead of adding 
a constant): e.g. 1, 2, 4 è 8, 16, 32 , 64 … 

• You can define your own frequently used custom series  
e.g. 2, 3, 5, 7, 11 è 13, 17, 23, 29, 31 … 

AutoComplete 
While you are typing a cell entry, Excel sometimes even guesses what you are going to type 
next based on what you have typed so far. When you are typing 
an entry that starts the same way as other entries in the same 
column (or row), it will suggest to complete your entry with the 
remaining characters of that entry.  E.g. when you are entering a 
series of products such as margarine, butter, cheese … in con-
secutive cells and you type “m” in a next cell, Excel will suggest 
the completion (m)“argarine” for you. You can press <Enter> to accept the suggested com-
pletion or just continue typing if you need to enter some different data. 

The difference between AutoComplete and AutoFill is that AutoComplete automatically sug-
gests a completion for text entered within the same cell; AutoFill fills other (empty) cells 
based on the contents of previous cells. 

Other Automatic Data Entry 
Tools 
Like MS-Work, Excel offers many other tools 
that can speed up data entry. 

AutoCorrect : will automatically correct typ-
ing mistakes, replace abbreviations with full 
length versions and insert common typo-
graphic symbols e.g. typing (c) will automati-
cally be replace with ©. I have added an 
AutoCorrect entry (in MS-Word!) which sub-
stitutes my initials jp with Jean-Paul Van 
Belle.   

Spell check : you can spell check a cell entry, a range or your entire spreadsheet by press-
ing the <F7> function key (or select the Spelling…option from the Tools menu). 

Undo : if you realise that what you have typed or done is incorrect, press the <Ctrl>-<Z> 
“undo” key (or click the Undo button on the Standard Toolbar).  

Find and Replace : a quick way of changing data entries across the entire spreadsheet (or 
a given range) is by selection the Replace option from the Edit menu (or press <Ctrl>-<H>). 

AutoFormat : recognises and applies the appropriate display format when entering a num-
ber e.g. a date, currency or percent. Described under More Advanced Cell Formatting.  
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More Advanced Cell Formatting 
The following screen gives an overview of the various types of formatting which can be ap-
plied to spreadsheet cells. 

The Formatting Toolbar 
The most frequently used formatting options are available from the standard Office format-
ting toolbar.  

The options include the following (from left to right) 

• Font type: the selection of Windows fonts depends on your specific installation, but will 
usually include Arial, Times (New) Roman, Courier, (Brush) Script and many fancier 
ones. 

• Font size: select a default size from the drop-down menu or enter any size of your liking 
(size is measured in points, 30 points measure 1 centimetre when printed) 

• Font style: apply any combination of the standard styles: bold, italics and/or underline. 

• Cell alignment: align cell entries to the left, centred or right aligned. Alternatively, infor-
mation can be centred and merged across several (previously selected) cells. 

• Number format: select the Currency, Percentage or Comma format and in-
crease/decrease the number of decimal places to be displayed. 

• Indent: indent information by one or several tabs. 

• Borders: select a cell border style and width from the drop-down menu. 

• Colours: select a cell background (“fill” or highlight) or text colour.  

Row height & 
column width 

Font type, size 
& style 

Borders, colours & 
patterns 

Alignment 

Number formatting 
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All of the above options were discussed in the Easy Start to Excel; you should have prac-
tised the formatting toolbar buttons on simpler spreadsheets. 

Selecting more advanced cell formatting 
There are a number of different ways in which you can apply cell formats that are not avail-
able from the formatting toolbar.  The following are the different ways in which to open the 
Format Cells window. 

• From  the Format menu (click on the menu op-
tion or press <Alt>-<O>) select the Cells… op-
tion (see right). 

• Right-click a cell and select the Format Cells…  

option  from the pop-up menu. 

• Press the <Ctrl>-<1> shortcut key combination 
to open the Format Cells window directly. 

If you find that you are using a particular format very frequently, consider adding it to the 
formatting toolbar using the Tools • Customize… • Toolbars menu option. Alternatively, 
create your own shortcut key for your favourite format option. 

Cell formatting can be applied in two ways.  

1. You can first select a format and then you type text – all information that is typed in 
the current cell will inherit this format. 

2. The other (usual) way is to first enter the text (which will inherit the default cell for-
mat) and afterwards select (a portion of) the text and apply the format to the high-
lighted text. 

Text within one single cell can have different font types, styles and sizes. If you select the 
Cell Format command while you are entering text in a cell, only the font tab will be available. 

Font Formats 
Click the Font tab in the Format Cells window 
to access the font options. Most options are 
available from the formatting toolbar, except 
for the following: 

Underline style: you can select double or ac-
counting underlining; the latter is slightly 
“lower” than standard underline. 

Effects: to select Superscript/ Subscript and 
Strikethrough effects. 
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Text Alignment within Cells 
The alignment tab allows you to control the posi-
tion of text (or numbers) with respect to the 
boundaries of the cells. You have three generic 
control options. 

Text Alignment. 
• The Horizontal alignment determines the 

position in respect of left and right borders of 
the cell. A special option worth mentioning is 
the Fill option, which repeats the text until it 
fills the entire cell. 

• The Vertical alignment determines the verti-
cal position of the text. Text can be posi-
tioned at the top, in the middle or at the bottom of the cell. 

• The Indent option allows you to indent text from the cell borders. 

Text Control 
This allows you to specify what must happen should the length of the text exceed the space 
available in the cell. 

The Shrink to Fit option will reduce the size of the text until the text can be displayed in the 
space available, whereas the Wrap Text option will wrap the text over several lines. Wrap-
ping text will increase row height and, unless row height is set to Auto, you may need to ad-
just the row height manually. 

Text Orientation 
Use this option to rotate text from +90 (vertical, text reads from bottom to top) to –90 de-
grees. Drag the red handle at the end of the line or enter the desired number of degrees. 
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Borders, Colours, Shading and Patterns 
The use of cell borders, colours, background shading and patterns can enhance the appear-
ance of text in a cell. 

Although borders around a cell can 
be created quickest by using the 
formatting toolbar icon, you have 
much more control when using the 
Border tab of the Format Cells win-
dow. This window allows you to se-
lect different line styles, even com-
bining them within the same cell!  

If you have selected a range of 
cells, you can apply the borders to 
the Outline (i.e. the outside) of the 
range or between the cell bounda-
ries of the cells making up the 
range i.e. the inside  (or delete bor-
ders by selecting the None preset). 

You can also select a specific colour for your border or even ap-
ply diagonal lines through your cell. 

Click on the Patterns tab to have a wider variety of background 
colours for your cells than is available from the formatting toolbar 
button. This will also allow you to select from a variety of back-
ground patterns.  

The foreground colour (i.e. colour of the text) can be set by clicking the Font Colour button 
on the formatting toolbar or by using the Font tab of the cell formatting window. 

Row and Column Formatting 
In addition to cell formatting, there are some additional formatting options that apply to col-
umns and rows only. 

Changing the width of a column 
You can change the width of (all the cells in) a column in one of the following ways: 

• Click the Column option from the Format menu and select  Width… to specify the 
exact desired width (in characters).  

• Drag the right border of the Column Name (or column head-
ing) until you have the desired width. 

• Double-click the right border of the Column Name to set the 
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column width automatically to fit the longest text entry in the column.  

Hide / unhide columns 
If you have a very wide spreadsheet, chances are that a number of columns contain “inter-
mediate calculations” or less important information. Select the Hide option from the Format 
• Column menu to hide one (or more) selected column(s). The information is still there and 
the columns will retain their original names, but they are now hidden from normal view.  You 
can unhide columns again by highlighting the column(s) to the left and right of the hidden 
columns and selecting the Unhide option from the Format •Column menu. 

Changing width of several columns 
Cell width is measured by the number of 
digits that would fit in a cell using the 
standard cell font (size). 

You can set the width of several columns 
at once.  

1. Select a number of columns by 
dragging the mouse cursor 
across the column names or select all columns by selecting the entire spreadsheet 
(click the top left square, to the left of the column A heading). 

2. Set the width of the selected columns by using the Format •Column •Width… 
menu option. 

Standard column width 
The standard or default column width is the width of the columns that have not been 
changed through one of the above operations. Set the default width of columns by selecting 
Format • Column • Standard Width…  

Changing the height of rows 
You change the height of a row, mutatis mutandis, in very much the same way you change 
the width of a column. Note that rows do not have a “default” height: they take the height of 
the largest default font (size) of any cell in the range (or larger if one of the row cells has 
been formatted to wrap around and the text consists of several lines). 

Because of the wrapping of text, row heights can often end up varying. It can be useful to 
change all row heights to match your text height:. 

1. Select all rows by selecting the entire spreadsheet (click the select entire 
sheet square i.e. to the left of the column A heading). 

2. Select Format •Row •AutoFit. 
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AutoFormatting a range 
Adjusting the font size, style, alignment, borders, background and colours of the cells in your 
spreadsheet can be very time-consuming. Luckily, there is a smarter way of doing things: the 
AutoFormat option. AutoFormats are pre-defined templates (or models) that apply a whole 
lot of consistent formatting automatically to a selected range. Below are some sample Auto-
Formats applied to the SA Sausage Sorcerer example.  

 

To apply an AutoFormat, follow these easy steps. 

1. Highlight the range of cells that you wish to apply the format to. A range typically in-
cludes a top row and left col-
umn with header and descrip-
tive information. 

2. Select Autoformat from the 
Format menu. 

3. Scroll through the list of avail-
able Autoformats. As you 
scroll, you will see an exam-
ple of each format to enable 
you to visualise the final look.  

4. Click the Options button if you 
only want to apply selected 
format elements e.g. only the 
alignment, patterns, colours or 
fonts. 
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Conditional Formatting 
It is also possible to apply different formats to one single cell, depending on certain condi-
tions. Usually the condition is related to the value in the cell. A typical example is where val-
ues outside an expected (or normal) range of acceptable values should be flagged very visi-
bly e.g. by means of a red background. You can specify several conditions, each with their 
own special formatting rules. 

To set a Conditional Format, perform the following steps. 

1. Select (highlight) the range of cells to which you wish to apply the format. 

2. Select the Conditional Formatting… option from the Format menu. 

3. Specify the condition under which the conditional format must be applied by complet-
ing the required information boxes. 

4. Click the Format… button to specify which format to use. 

The example below applies a special format (bold, italic, yellow, thin border and dot pattern) 
to all cells within the selected range that contain values between 300 and 750.  

Alternatively, the cells that contain a negative value (less than 0) will have horizontal lines on 
a light grey background with a dotted border.  
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Number Formatting 
Although number formatting is actually one 
of the cell formatting options, it deserves 
special consideration because of its impor-
tance. Most spreadsheets contain many 
numbers (and formulas) and it is important 
to realise that numbers can be formatted in 
different ways. 

Common number formats 
The following are the main number for-
mats. 

• General: displays as much of the 
number as possible. 

• Number: displays a fixed number of 
decimal places. If a number has more significant digits after the decimal than need to be 
displayed, it gets rounded (for display only, not for calculation purposes). If it has less, 
zeros are added. E.g. both the numbers 123.44996 and 123.45 would be displayed as 
123.4500 in number format with 4 decimal places. 

• Currency: uses a currency symbol (R, $, Fr, …) and fixed number of decimal places 
(usually two or none). The currency symbol (and its placement before or after the 
amount) is determined by your system configuration, but the default value can be over-
ridden for selected cells.. 

• Accounting: similar to the Currency format but with lots of space between the currency 
symbol and the number (decimals and currency symbols are vertically aligned). 

• Percentage: displays a number as a percentage with a given number of decimal places. 
The number is multiplied by 100 and a %-symbol is added.  E.g. 0.5 or ½  equals 50% 
and 2.25 equals 225% in percentage format. 

• Fraction: displays a number as a fraction. You can select one, two or three-digit frac-
tions, or the standard (US) stock fractions of eighths and sixteenths. The integer part of 
the fraction will precede the fraction and is separated by spaces. For example 4.125 can 
be displayed as 4 1/8 and –2.33333333 as –2 1/3. 

• Scientific: uses an exponential format to indicate the power of ten by which the number 
(mantissa) must be multiplied.  This format is very useful for extremely large and very 
small numbers. 123,000,000,000 will be displayed as 1.23 E+11 (move the decimal point 
11 places to the right or multiply with 1.23 with 1011); 0.000000123 is equivalent to 1.23 
E-07 (move the decimal point 7 places to the left or multiply with 10-7). 

• Text: treats a number as a text label instead of a value (e.g. 320 in BMW 320-series). 
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• Custom and Special: allow you to apply special formats to number-like codes e.g. tele-
phone numbers, bank account numbers, product codes etc. 

The following are illustrative examples for some of the above formats. The date and time 
formats will be discussed under a separate heading. 

 

What you see is NOT what you get 
It is extremely important to note that the display format does not affect the internal accuracy 
or representation of the number.  If a value of 1.2345 has a currency display format with 2 
decimal places, it will appear as R1.23 on screen (and on print-outs) but for all calculations 
the full precision will be used. If another cell would multiply this value (say the price of an 
item as calculated by converting with the foreign exchange rate) by a factor two (represent-
ing the number of items ordered), the total value would be displayed as R2.47 (which is a 
rounded display for 2.4690), not R2.46 as might be expected (see example 2 below). 

Excel typically uses a precision of 15 significant digits for all numbers in the spreadsheet, but 
numbers are usually only displayed with a limited precision.  The spreadsheet extract below 
illustrates a few more examples. (Note: it is possible to set the Calculation Options to “Preci-
sion as displayed” i.e. “what you see is all the precision you get”.) 
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Automatic Number Formatting 
Excel will automatically apply certain number formats for you as you enter data.  Here are a 
couple of examples. 

Enter 3 3/5 and Excel will store the value 3.6 and apply the Fraction, 1 digit format. 

Enter 3-Mar-98 and Excel will store it as a date and apply the date format (see later). 

Enter 3:40 and Excel will convert it into a time and apply the time format. 

Enter R3.40 and Excel will apply the Currency, 2 decimals format. 

Enter R3,000 and Excel applies the Currency, 0 decimals format. 

Enter 50% and Excel applies the Percentage (0 decimals) format to the value 0.5. 

Sometimes Excel may become a bit confused. If you enter 3/5, Excel assumes that you want 
to enter a date (3rd March). If your intention was to enter the value three-fifths (0.6), you 
need to precede the fraction with a “dummy” integer value of 0 in order to “force” Excel into 
the fractional format i.e. you would enter 0 3/5 instead! 
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Excel Formulas 

Excel’s Built-in Functions: the Basics 
Just like scientific and financial calculators offer much more advanced functionality than the 
mere basic arithmetic operations, 
Excel has a great number of spe-
cialised functions built in. The 
normal way of using the basic 
functions is by typing in their 
name and their arguments. 

If you use a more complex or less 
frequently used function, you may 
not remember its exact name or 
argument.  

Make use of the function wizard 
to assist you.   

1. Click the Insert Function 
button  

2. Select the type of function 
from the function category menu  

3. Click the name of the function you’re interested in to see its description and the type 
of arguments it takes.  

4. Excel will assist you in completing the function by prompting you for each of the ar-
guments the function requires. Remember that you can move the Function Argu-
ments window around if the cells you want to see are obscured. 

 

Function wiz-
ard button 

Select type 
of function 

Select the 
function 

Read its 
description 
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If you do remember the name of the function, Excel will prompt you for the required and op-
tional arguments as you type. 

 

A function consists of the following elements: 

• Function name: you can enter a name in lower or upper case but Excel will automati-
cally convert it to upper case. 

• Round brackets: this identifies it as a function. 

• Argument(s): these are the values or cell references that the function uses to calculate 
its result. (Mathematicians refer to the arguments as the independent variables.)  Most 
functions require more than one argument; if this is the case, the arguments usually have 
to be in a strict order. Arguments are separated by commas. 

An example of a function is: 

=ROUND(A5,2) 

This function will round (hence the name of the function) the value in cell A5 (the first argu-
ment) to the nearest one-hundredth (two “decimal places” to the right of the decimal point, as 
indicated by the second argument) and place its result (the rounded value) in the current 
cell. 

Note that the arguments of functions can themselves be any formula or function. Using a 
function within a function is called nesting, as in: 

=B7+AVERAGE(MIN(A2:A5),MAX(B2:B5)) 

This formula first finds the lowest value in range A2:A5, then calculates the highest value in 
B2:B5 to B7, averages the two and adds the result to B7.  

Some formulas can be nested extremely deeply, which makes them almost impossible to 
review or change at a later date. If you find that you have one of these very complex formu-
las, consider breaking up the formula into smaller components by storing some intermediate 
calculations in other cells. 

The best way to get an overview of the variety and range of functions that are available in 
Excel is by browsing Help or by using the function wizard. We will briefly introduce some of 
the functions that you are likely to use in a business context. 
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Statistical functions 
Statistical functions are used to summarise large amounts of numbers. The following are the 
more basic statistical functions. The sample values are based on the data set that is high-
lighted. 

Mathematical functions 
Although you are unlikely to use any of the advanced mathematical functions such as those 
dealing with imaginary numbers or trigonometry, business spreadsheets often need a way of 
dealing with decimal fractions and rounding values. The following are some of the functions 
that you will sooner or later deal with and sample values (based on A1 = 1234.563). 

 

You should remember that What-You-See-Is-NOT-Always-What-You-Get.  A number may 
be displayed with only 2 decimals but the real underlying value that is used for calculations 
may have far more precision. Refer to the discussion earlier in this document. This is why 
you may need some of these functions – especially the ROUND-function is handy! 
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Another very useful function is the random number generator. You can use this function 
when testing a spreadsheet model structure without having access to actual data (yet) or to 
generate forecast data to test out various business scenarios. You generate random num-
bers by means of the following formulas: 

=RAND( ) : generates a random number between 0 and 1 

=RANDBETWEEN(lower limit, upper limit) : generates an integer random number between 
the specified lower and upper limits. Note that the RANDBETWEEN function is only avail-
able if you have the Analysis Toolpak Add-in installed.  

Random numbers are re-generated each time a(nother) cell value in the spreadsheet 
changes. You can also “force” new random numbers to be generated by pressing the Recal-

culation key: the <F9> function key. 

On the left is a more playful example. 

Each time <F9> is pressed, two new numbers (be-
tween 1 and 6) appear in cells B17 and B18. Here I 
was lucky to throw double-two! You can make dice 
that throw any range of numbers. 

Notes: 

The RAND function has brackets but doesn’t require any arguments between the brackets. 

Don’t confuse the RAND function name with the South African currency – the similarity  is 
just a coincidence. 

Where the RANDBETWEEN function is not available, you can use the following equivalents: 

• =RAND( )*range+base : will generate a number between base and (base+range) 

• =INT(RAND( )*range+base+1) : will generate integer numbers. 
E.g. to generate the dice numbers above the function =INT(RAND( )*6+1) was used:  

o RAND( ) generates (evenly distributed) numbers between 0 and 1  

o RAND( )*6 generates numbers between 0 and 6 

o RAND( )*6+1 generates numbers between 1 and 7 (but never quite 1 or 7!) 

o INT(RAND( )*6+1 returns the integer part of the above number i.e. numbers 
between 1 and 6. This is the function used in the casino example above. 
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The Excel IF function 
Arguably the most often used logical function is the IF function. This function allows you to 
return any one of two values, depending on the outcome of a condition. 

The IF function has three arguments: 

• The condition (or criterion) that has to be checked. You make use of the following opera-
tors to construct your condition:  = (equal),  > (greater than),  < (less than),  <> (not 
equal), >= (greater than or equal),  <= (less than or equal). 

• The value that will be returned if the condition holds true; the value can be any formula. 

• The value that will be returned if the condition does not hold true i.e. is false. 

The following are some examples of simple applications of the IF function. 

Example 1: calculating tax on positive income only 
A company will only be liable for income tax if it earns a positive income. Assuming that the 
tax rate is 40% and the income is contained in cell D20, the following formula would calcu-
late the income tax due (spaces added for legibility): 

=IF (D20 > 0, D20 * 40%, 0) 

This should be read: If   (income exceeds 0) then (tax = income * 40%) else (tax = 0). 

An alternative but equally valid way would be: 

= IF (D20 < 0 , 0, 40% * D20) 

If (income is negative) then (tax = nil) else (tax = 40% of income) 

Example 2: calculating a pass or fail 
Assuming that 50% is required for a student to pass, the following formula will calculate the 
Pass/Fail symbol (assuming the student mark is in E10): 

=IF ( E10 >= 50% , "Pass" , "Fail" ) 

If (mark is greater than or equal to 50%) then (symbol = Pass) else (symbol = Fail). 

Note that, since the value of the symbol is text rather than a number, the symbols are en-
closed in double quotes.  

If you want nothing to be returned if a student passes, you could use the formula: 

=IF (E10 < 50%, "Fail") 

This would display nothing for students who obtain at least 50% and flag only the Fail stu-
dents.  
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More complex conditions 
More complex conditions can be expressed by using the logical functions AND( ) and OR( ) 
or by using nested conditions.  The following are some examples: 

=IF ( OR (E2 < 50%, F2 < 50%, G2 < 50 %), "Fail", "Pass") 

If (E2 < 50%  or F2 < 50% or G2 < 50%) , then fail, else pass. You fail if you have less than 
50% in either E2,  F2 or G2 (or more than one). You only pass if you have 50% or more for 
all three.  This is quite different from: 

=IF ( AND(E2 < 50%, F2 < 50%, G2 < 50 %), "Fail", "Pass") 

Here you pass as soon as you have at least 50% for any one of E2, F2 or G2 i.e. only one 
single 50% score is sufficient to secure a Pass. 

The nested IF allows you to have more than two options. 

=IF ( D2 < 50%, "Bad", IF(D2 >=70%, "Excellent", "Good")) 

If D2 is less than 50%, then you get a "Bad" symbol, If D2 is at least 70%, you get an "Excel-
lent" symbol, else (if D2 is at least 50% but less than 70%) you get a "Good". 

When you get too many nested IF conditions, you should consider using the LOOKUP func-
tion. Compare the two following statements that aim to assign a symbol from A to F based 
on the final mark stored in D2: 

=IF ( D2 < 40%, "F", IF (D2 < 50%, "E", IF (D2<60%, "D", IF (D2 < 70%, "C" ,  
IF (D2 < 75%, "B", "A") ) ) ) ) 

(Note: the order is very important!). A much neater and less error-prone formula is: 

=VLOOKUP ( D2, Symbols, 2) 

where Symbols is the range that holds a list of symbols and the corresponding mark cut-off. 

Lookup and reference functions 
A common business situation is where values have to be looked up in tables. Excel offers a 
number of functions that will enable you to choose a particular value from a whole list or set 
of values. 

• =CHOOSE(choice,option1,option2, …): allows you to choose a value from a list (op-
tion1 etc.) depending on the value of your choice argument (0, 1 …) 

• =VLOOKUP(lookup value, range reference, column number): locates a value (the 
lookup value) in the first column of a columnar table (range reference) and selects the 
corresponding value in the nth column (column number). 

• =HLOOKUP(lookup value, range reference, row number): locates a value (the lookup 
value) in the first row of a horizontally organised table (range reference) and selects the 
corresponding value in the nth row (row number). 
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These functions are best illustrated by means of examples. 

Example 1: UCT Parking Fees. 
On the left, you find a simple table with the parking fees for a particular organisation. The 

fees vary according to the status of the individ-
ual, which can be referenced by means of a 
code. E.g. a student has a code of 1 and is li-
able for an annual parking fee of R180, whereas 
academics (code 3) pay R320 annually. 

An Excel function can be constructed to quickly 
“look up” the parking fee amount due, based on 
the code entered by the user. Since the codes 
used here are sequentially numbered, there are 
two basic ways of constructing the formula in 
B13. 

Using the CHOOSE function: 

(B13)  =CHOOSE(B11,180,250,320,580,200) or, slightly better: 

(B13)  =CHOOSE(B11,C5,C6,C7,C8,C9) 

Depending on the value in B11, the CHOOSE-function selects (chooses) one of the amounts 
(values) which follow.  The first version of the formula is not very desirable: when UCT’s 
management decides to increase the parking fees, you would not only need to update the 
schedule but also change the formula(s)! A problem with the CHOOSE function in general is 
that it requires “sequential” codes starting from 1. Another problem is that the formula can 
become quite long if there are many possible options. There is a better alternative. 

Using the VLOOKUP function: 

(B13) =VLOOKUP(B11,A5:C9,3) 

This formula should be read in the following way: look the value in B11 up in the first column 
of the table A5:C9 and return the corresponding value (i.e. on the same row) in the 3rd col-
umn. 

Since this example is perhaps a bit too trivial, let’s illustrate the lookup-function with a more 
realistic example. 

Example 2: The South African income tax rates (for natural persons) 
The table on the next page lists the income tax rates for natural persons in South Africa for 
the 1997 tax year. (The rates are adjusted annually but the principle remains.) South Africa 
has a system of progressive taxation: as your taxable income increases, you pay a higher 
tax rate. 

For example, if your taxable income is R34,500, you would pay tax as follows: 
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• 17% tax on the first R15000 (or R2,550),  

• 19% on the next R5,000 (tax=R950),  

• 21% on the next R10,000 (tax=R2,100), and finally  

• 30% on the last (highest) R4,500.  

Since the first three steps will apply to any taxable income between R30,000 and R40,000 
these amounts have already been “pre-calculated” (R2,550+R950+R2,100=R5,600) and this 
can be read off the table. You just need to calculate the marginal tax for the highest tax 
bracket, for the amount in excess of R30,000. 

The formulas in G15 to G19 calculate the tax in two separate steps. 

• G15 looks up the taxable income (as given in G14) in the first column of the entire tax 
table (E4:I12). Excel’s LOOKUP-function will go down the values in the first column 
(which should be in increasing order!) until it finds an exact match, or stops before the 
next larger value. In our case, it will “stop” in row 8 since the value in row 9 (E9) is 
R40,000 i.e. exceeds the lookup value.  It will now move across the same row to the third 
column (the last argument of the function = 3) and return this value, which is R5,600, or 
the “fixed” portion of tax due for any taxable income between R30,000 and R40,000. 

1) Lookup this income 

2) In this 
tax table 

3) in this 
row 

4) value in 
3rd column 
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• G16 looks up the marginal tax rate for the portion of the taxable income exceeding the 
R30,000 (the lower break of this tax bracket) in the same manner (except that it is lo-
cated in the 4th column). 

• G17 calculates the amount on which the marginal rate should be calculated i.e. by how 
much the taxable income exceeds the lower break of the applicable tax bracket (or 
“band”). 

• G18 calculates the actual marginal tax due i.e. G16 x G17 

• G19 calculates the total tax due, i.e. the sum of the tax in G15 and G18.  

Below are two more examples – see if you can work out how the VLOOKUP-function arrived 
at its values. 

Notes: 

• The HLOOKUP function works in a similar way, except that it assumes that the table is 
organised in rows rather than columns. The lookup value will be checked along the first 
row of the table (left to right) and the function will return the corresponding entry in the nth 
row of the same column. 

• Some other spreadsheet programs start numbering columns (or rows) at 0 instead of 1. 

• The first column (or row) of the table should be in increasing (or ascending order) – you 
may wish to use Excel’s data sort feature if your data isn't organised sequentially. (Use 
the Sort Ascending button on the standard toolbar.) 

• The LOOKUP function looks for values that equal or exceed the lookup value (but are 
less than the next value). Sometimes you require an exact match with the value in the 
table (e.g. when looking up product codes, names or student registration numbers): the 
LOOKUP function allows you to specify a(n optional) fourth argument FALSE if you re-
quire the exact match. 
=VLOOKUP(“BNDJAM007”,A2:F850,4,FALSE)  
will only return a value if there is a student with the registration number BNDJAM007 in 
the A column. 



24          © Jean-Paul Van Belle <jvbelle@commerce.uct.ac.za Using Excel 2002 

Convert Calculated Values in Constants Using Paste Special 
Sometimes, it is necessary to turn the results of a formula into permanently fixed constants 
(e.g. when formulas refer to values in other spreadsheet files which may not be available 
later or if you want to reduce calculation time/memory requirements). First Copy  the range 
with the formulas whose values you wish to make permanent (with Edit • Copy  or <Ctrl>-
<C>) and then select the Paste Special  option from the Edit menu.  You can now elect to 
copy only the values (or the formatting) from the clipboard to another area of the spread-
sheet or over the original cell formulas. If you have used very complex formulas, you are well 
advised to keep a copy of the formula somewhere in the spreadsheet (e.g. as a text entry). 

More on Using Logical Conditions in Formulas 
Logical conditions were discussed with the IF statement. It is possible to use the way Excel 
evaluates logical conditions in different ways. 

The following example shows how Excel assigns a truth value to a logical condition. 

 

With A2 assigned the value 3 and A3 the value 5, the formulas in column D (shown in for-
mula form in column C) evaluate to either TRUE or FALSE.  

Note in particular the funny formula “ =A3=A2 “. In fact, the following is a perfectly legal for-
mula:  =(A2<A3)=(A3<A2) which evaluates as FALSE since the truth value of the statement 
A2<A3 is not the same as the truth of the statement A3<A2.  

Internally, Excel assigns a numeric value of  1  to a TRUE condition and a numeric value of  
0  to a FALSE condition. 

Hence the somewhat perplexing truth of the last formula  “=A2=A3=A4”. If there are no 
brackets, Excel evaluates from left to right, thus A2=A3 evaluates as FALSE and internally 
stored as 0. Since A4 is an empty cell, it is considered to be  0  in formula calculations and 
thus  0 = 0   which is true! 

You can therefore use evaluated conditions in formulas as shown in column G whereby a 
number is added to the truth values in column D. This feature enables you to write some IF 
formulas differently e.g. the tax formula given earlier to calculate tax on positive income  = IF 
(D20 > 0 , 40% * D20 , 0)  could be rewritten as =(D20>0)*D20*40%. Note that formulas like 
these are very difficult to understand or check, so we advise that you should avoid using 
them as much as possible. 



Using Excel 2002  25 

Mixed addressing 
In the introductory module, the difference between absolute and relative cell referencing was 
introduced. There exists a hybrid form between absolute and relative cell addresses. This is 
called a mixed reference and, though it takes quite a bit of effort to understand, it may save 
you invaluable time when building more complex spreadsheets.  

The following example calculates how much R1000 will be worth when it is invested for a 
various number of years (read off vertically) and at different interest rates (read off horizon-
tally). It is assumed that you leave the interest (which we’ll calculate on an annual basis for 
simplicity’s sake) in your account: this is called compounding. The power behind com-
pounded interest is that, in the following year(s), you earn interest on previously accumu-
lated interest. While the initial additional earnings are indeed quite small, they tend to build 
up to dramatic amounts after ten or more years.  The formula used for compound interest is 
the following: 

 Balance after n years = Initial capital   x   (1 + interest rate) number of years  

Although this formula looks frightening, it is actually not all that different from the formula that 
is used for simple interest i.e. where no interest is earned on previous interest. 

 Balance after n years = Initial capital   x   (1 +  interest rate x number of years)  

The compound interest table can be built very quickly in Excel. (Use AutoFill to complete row 
2 and column A; and AutoFormat if you want a more attractive formatting of the table). 
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The element of most interest (excuse the pun) in the table is the formula that calculates your 
final balance given the interest (in row 2) and the number of years you invested (in column 
A). This formula was only entered once and then copied across the entire table range. Below 
is an extract of a portion of the same spreadsheet in formula view. 

We will analyse the formula in B3 step by step. 

• The base formula is   = Initial Capital * (1 + interest rate) ^ Number of Years    

• Using relative referencing only, this would be  = G1 * (1 + B2) ^ A3  for B3. 

• We have entered it using mixed referencing as  = $G$1 * (1 + B$2) ^ $A3  for B3. 

Initial Capital is in cell G1. Since this reference should always be to G1, no matter where the 
formula is copied to, it should be an absolute reference i.e. $G$1. 

The interest rates can always be found in row 2, irrespective of the row to which the formula 
will be copied, hence the reference to row 2 should be absolute.  However, for the column C, 
the appropriate interest rate is not B2 (8%) but C2 (10%); and the interest rate for column D 
is 12% i.e. D2. Hence, when the formula is copied across different columns, the column ref-
erence should change accordingly, and therefore the column reference must be relative. 
This is precisely a case for mixed cell referencing: B$2.  Check for yourself how the B$2 
changes to C$2, D$2 etc when moving (copying) from column to column but never changes 
when going down the rows: the $2 is the absolute (or unchangeable) part of the formula. 

Exactly the opposite is true for the reference to the number of years. These can be found in 
column A. For B3, the number of years is 1 i.e. A3. The reference to column A should never 
change when copied across from column to column, hence this part of the address should 
be fixed or made absolute: $A.  However, for row 4, the number of years is 2 and the refer-
ence should change to A4, the row reference must be relative i.e. no $-sign. Check for your-
self how $A3 changes to $A4, $A5 etc when moving (copying) from row to row but never 
changes when moving across columns: the $A is the absolute part of the mixed cell refer-
ence. 

Using Headers as Cell Range Names 
There is still another, much more intuitive but sometimes quite confusing way of referencing 
cells. You will remember that, instead of having to type in cell addresses when entering a 
formula, you can avoid typing mistakes by just clicking the cell you wish to insert; this is 
called the pointing method.  Nevertheless, when reading formulas it is still not always imme-
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diately clear what the cell references mean. There should be an easier way to read the for-
mulas, and there is!  Refer to the simple spreadsheet which was introduced in the introduc-
tory module to illustrate the concepts of relative and absolute addressing. 

 

Instead of entering the formula (D5): =B5*C5, you can enter the much more legible and 
intuitive formula =quantity*price. Is Excel clever enough to figure out what you want? YES! 
Similarly, you can enter the following: 

(E5) =Total(excl)*$E$2 (You still have to refer to the VAT Rate as $E$2) 

(F5) =Total(excl)+VAT 

You can even enter the following in E8: instead of  =SUM(E5:E7) 

(E8) =SUM(VAT) 

Excel is normally sufficiently clever to infer the cell reference from a descriptive cell name by 
using the context i.e. from column and row labels. Sometimes, however, you may prefer to 
give Excel explicit instructions about names: you can assign a name to any cell or range of 
the spreadsheet. In fact, it is advisable to always declare your cell names using a formal 
procedure to avoid duplicate names and/or ambiguities.  The quickest way to assign a name 
to a cell or range is highlight the cell (or cell range), click on the name box on the left of the 
formula bar and type in your desired name. 

 

For the invoice example, we assign the name VATrate (capitalisation is not important) to the 
cell E2, so we could actually use the formula  =Total (excl)*VATrate  in E4:E6.  

And there is an important added bonus: we don’t have to worry about absolute addressing in 
the formula any more!. Cell and range names make your spreadsheet formulas much easier 
to read. You can also use the names whenever a command requires a range from you, e.g. 
for graphs or printing. 

 

Select cell 
or range Enter cell name in 

the name box 
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Print Options 
To print your spreadsheet using the default settings, click the Print button  to print out the 
current spreadsheet on your default printer. Note that hovering your mouse cursor above the 
button will display your default printer.  

The Print dialogue window 
To change print defaults, press 
<Ctrl>-<P> or select the File • 
Print…  menu option to bring 
up the standard Print dialogue 
window. This will allow you to 
change the number of copies, 
the printer and which pages to 
print.  

You can also select a particular 
range or a number of workbook 
sheets (<Ctrl>-click the re-
quired sheet tabs) prior to 
bringing up the Print window. 

Changing the Page Layout 
You will often want to customize the layout of your spreadsheet printout. To access the Page 
Setup dialogue window from either: 

• Click the Print Preview button 

 and click Setup… from the 
preview screen, or  

• Select the File • Page 
Setup… menu option. 

If you are working with a large 
spreadsheet, you will often want to 

scale the print-out, either to a fixed percentage of normal size, or else fit the print-out to a 
specified number of pages. Many spreadsheets are too wide to fit on a portrait-orientated 
page, so you will often set the default paper orientation to Landscape.  

 

 

 

 



Using Excel 2002  29 

Adding Headers or Footers 
Click the Header/Footer 
tab to print a common 
header or footer on each 
page. Apart from includ-
ing standard text, you 
can customize the 
header/footer to include 
page numbers, file 
names, date and/or time printed etc. 

Setting Sheet Options 
Extremely useful are the different Sheet 
options of the Page Setup window that 
allow you to:  

• repeat certain columns and/or rows 
on each page 

• print the faint grid lines between the 
cells 

• change the cell range (print area) to 
be printed. 

Adjusting Print Margins 
The print margins can also be defined from the Page Setup window or, more visually, by 

clicking the Margins button in the Print 
Preview window and dragging the mar-
gin borders as desired.  

The Print Preview window also allows 
you to adjust the column widths for 
printing purposes only, without chang-
ing the actual column widths of your 
spreadsheet. Drag the column border 
handles at the top of the page to 
change the column widths. 
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Viewing large spreadsheets 
As your spreadsheets become larger and larger, you may not be able to see all of the rele-
vant cells in the same window.  There are a number of different ways in which you can rem-
edy this situation. 

Most of the following methods to see more of your document, apply to other applications 
(such as MS-Word), too. 

• Change the window zoom factor on the standard toolbar (see right). Select 
any factor from the drop-down box or enter your own % factor. (This option 
can also be selected from the View menu.) The smaller the %, the more you 
can see, e.g. 50% shows much more than 100% but the text may be too 
small to be readable. 

• If your document or application window is not maximised, click the maximise button. 

• You can also (temporarily) remove all scroll bars, toolbars, title bar and status bar by se-
lecting Full Screen from the View menu. Only the menu bar will remain on-screen and 
the rest of your “screen estate” will be devoted to your spreadsheet. To 
switch back to your normal editing screen, click the Close Full Screen 
option on the small ”floating” Full Screen window (you can move this 
window out of your way by dragging its title bar). 

• Some pop-up windows (especially those gener-
ated by the wizards) require you to enter data 
but may be obscuring your view. It is not always 
feasible to move them out of your way by drag-
ging the title bar due to their size. These win-
dows often have a collapse button that removes 
the window except the data entry (dialogue) box. 

Splitting document windows: you can split the 
document window both horizontally and vertically to 
view different (rectangular) areas of your same document: these areas are called panes. Do 
this by dragging the little bar at the top (right) end of the vertical (horizontal) scroll bar down 

(left) to the desired posi-
tion. (This is similar to 
Word’s split windows.) 
You can also select the 
Split option from the 
Window menu. Double-
clicking any of the win-
dow splits will remove 
the split window.  Note 

how this split window allows you to check how much your R1,000 will be worth after 25 
years, invested at 24% p.a. 

Collapse 
button 
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Working with dates and time 
Many spreadsheets incorporate dates and, to a lesser extent, time. Often you will want to do 
calculations with dates such as adding 7 days to the current date to calculate an expected 
delivery date. Excel has a very interesting way of dealing with date and time arithmetic. 

The underlying philosophy for date manipulation rests on the following principles: 

• Excel counts days as consecutive numbers. Each day (date) is represented by a unique 
number. 

• Excel started counting days from the 1st Jan, 1900, which can be considered “Day 1”. 2nd 
Jan, 1900 was day 2; 31st Dec 1900 was day 366; 1st Jan 1901 was day 367; 1st April 
1998 is day 35886; 2nd April 1998 is day 35887; 1st Jan 2000 is day 36526 etc. 

• A fractional part of the day represents the time of the day.  Lunch time on 1st April 1998 
is 35886.50 (with 35886 representing the Day number corresponding to 1st April 1998 
and the fractional .50 representing the exact middle of the day).  6:00 in the morning (1st 
April '98) is 35886.25 (one quarter of the day); at 8:00 in the morning is 35886.333333 
(one third of the day) etc. 

Internally, Excel doesn’t handle dates (or time) any differently than any other number. The 
only difference lies in the display of the number: dates (and time) have a special number 
(display) format. 

Normally, you don’t have to be aware of the internal date arithmetic since you can enter a 
date (or time) directly into a cell and Excel will handle all the technicalities (i.e. convert it into 
its date number and apply the proper date format). 

For instance, to enter the date 1st April, 1998 in a cell, you could enter any of the following: 

1 April 1998   or   1-Apr-1998   or   1998/04/01      or    1998-04-01 

To find the difference between two dates, just subtract the one from the other. The following 
spreadsheet calculates my age expressed as the number of days. 

Note the use of the date formula  =NOW( )  which returns the current date (and time).  There 
are many ways of formatting dates and a wide variety of functions that allow you to do so-
phisticated date arithmetic.  E.g. WEEKDAY allows you to determine which day of the week, 
DAY finds the day-of-the-month (1-31) etc. 

Typically, date arithmetic works with the non-decimal (integer) part of the date number and 
time arithmetic with the decimal (fractional) part of date numbers. 
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Some notes on spreadsheet design 

Think before you act 
Because Excel makes it so easy to start building a model straight away, many people start 
constructing models before they have thought about the detailed design and layout. They 
then spend much time trying to change the format or, even worse, find that their model isn't 
flexible enough to accommodate changes at a later stage. So, before you rush out and start 
building a slightly more complex model, take some time to think through the logic and layout 
first. 

A correct model is more important than attractive formatting 
It is much more important to have a model that produces the correct figures than to have one 
with all the colours and borders you can think of but which produces incorrect result. First try 
to build a model that works correctly; once you are happy with the results (did you double-
check?) you may want to spruce it up to make it more attractive. 

Conversely, don't be overly impressed with other people's extremely attractive spreadsheet 
models: check their logic and see if the figures make sense. 

Double-check your model's formulas with common sense and Ex-
cel's audit tools. 
Before relying on the results of your model, take some time to check if the values in your 
spreadsheet are of the right order of magnitude. Though you may miss some finer errors, 
many incorrect spreadsheet formulas produce figures that are way off the normal "ball-park 
figures".  A good way to check a spreadsheet is by plugging in some historical data and see 
how well the spreadsheet numbers correspond to actual figures.  (Note: the process of re-
moving mistakes from models, which are actually nothing but a type of financial computer 
program, is called debugging.) 

Whether you suspect mistakes, you are busy building your own spreadsheet or even if you 
are only wanting to check the logic of someone else's spreadsheet, you are well advised to 
make full use of Excel's advanced auditing tools. 

When you edit a cell's formula by pressing the <F2> edit key, Excel will use a colour coding 
scheme to indicate which cells are being referenced in the formula. Each cell reference in 
the formula is displayed in a different colour and the values in the corresponding cells have a 
border of the same colour around them. 

You can get a more visual impression of the logic of your spreadsheet by looking how cells 
are interrelated through formulas.  Use the Tools • Formula Auditing menu options for 
this. You may wish to have the Formula Auditing  toolbar permanently available if you antici-
pate quite a bit of cell "auditing". 
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The above figure shows a "first generation" of precedent arrows (Tools •Formula Auditing 
menu option / toolbar button).  The arrow shows how the value in F8 is derived from cells F5 
to F7. 

 

By selecting the same option (or clicking the same button) again, you can determine where 
the values in F5 to F7 come from. A third click will trace the dependencies a further step 
back. 

 

You can use the Audit tool also to check dependencies in a "forward" manner i.e. which cells 
are dependent on (or influenced by) the current value. You can also trace where the root of 
all the error values that appear all of a sudden, come from. 

Use multiple sheets where applicable 
If you have several spreadsheets that use the same basic data but are of a fundamentally 
different structure, keep them together (and linked) by using different sheets (or pages) in 
the same Excel document. This allows you to change the layout and formatting of any one 
sheet (e.g. changing column widths or inserting rows) without affecting the integrity of the 
data on the other sheets but it still keeps all data tightly grouped together. 
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Cell references to cells on other sheets become slightly more complicated since they now 
need to be prefaced with the name of the sheet and an exclamation mark ("!"). The above 
formula gives a simple example where the price of the item is stored on a sheet named list 
and can be looked up using the cell (range) reference list!A9:B11.  (If the formula is to be 
copied, an absolute range reference should be used i.e. list!$A$9:$B$11.)   

Note that a much better cell formula would be  =VLOOKUP(Item,PriceList,2) with Item the 
"automatic" name for A5, and PriceList a name given to the range containing the price list. 
When using cell names, the reference to the sheet can be omitted and you also don't have 
to worry about the relative or absolute references any more. Yet another reason to use 
range names. You can rename a sheet by double-clicking (or right-clicking) the sheet tab at 
the left of the bottom scroll bar). (Cell ranges are named by selecting the range and clicking 
the name box.) 

 

It is equally possible to make cell references to cells in other spreadsheets (Excel docu-
ments) but this practice is usually only recommended if documents become too large to be 
handled as separate work sheets. 

Using different sheets is also recommended if your data has a distinct three-dimensional 
structure e.g. a large Excel document may contain sales data for many products (listed verti-
cally, one row per product), for various regions (listed horizontally, one column for each re-
gion) and for a number of months or years (organised in different sheets, one sheet for each 
time period). Although Excel is configured initially to create new documents with a fixed 
number of sheets (usually three), you can easily add or delete sheets by right-clicking the 
sheet tabs or using the appropriate Insert or Edit menu options, respectively. You can also 
move sheets in a different sequence by clicking their tabs and dragging them across to their 
new position. 

Note that it is possible to refer to cell ranges that span several sheets at once using a 3D 
reference e.g. =SUM(Sheet1:Sheet3!A1:B2) will sum the range A1:B2 across Sheet1, 
Sheet2 and Sheet3. You can also refer to a cell (or range) in another workbook e.g. 
=SUM([Model.xls]Relations!D17:D24) refers to the sheet "Relations" in the workbook file 
named "Model". 

Rename Sheet3 by 
double-clicking Tab 
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Creating Charts 
Charts are an excellent way of presenting large amounts of numerical information in an easy 
and intuitive format. Excel makes it extremely easy to convert any data table into a chart 
quickly. On the other hand, Excel allows you to customise your chart to an amazing degree 
and you can spend many hours playing around with the many options and features which 
Excel offers. 

When you create a chart, it becomes an intrinsic part of your spreadsheet; they either have 
their own sheet or they can appear anywhere inside one of the worksheets. Note also that 
charts always reflect the underlying data in the spreadsheet: as soon as the values change, 
the chart will be updated automatically. 

The "quick and dirty" way to create a chart 
Before you create a chart, make sure that your data is organised in a table format. Excel 
usually takes a good guess about how your chart should look like, but it helps to give Excel a 
little hand by bearing the following in mind. 

• Label your columns and rows with appropriate (and short) labels. 

• Don't have a blank row/column of cells between labels and data. 

• Preferably keep the data in contiguous cells. 

• Sort your data columns and rows in the same order as you wish them to appear on the 
graph. 

The following is an example of a table that is ready to be converted to a graph. 

 

The quickest way to create a chart is by selecting any cell in the table and pressing the 
<F11> function key. This will produce a relatively unsophisticated but entirely acceptable 
chart.  You have literally created a chart by just pressing one single key! 
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This chart will be put in a separate worksheet with the name Chart1.  You will be able to 
customise this chart using the Chart command (which replaces the Data command on the 
menu whenever your cursor is on or in a chart). 

Using the Chart Wizard. 
If you want more control over the creation of your chart, use the Chart Wizard instead. Al-
though the process takes slightly longer, you will save a lot of time because  you won't have 

to customise the chart afterwards. A wizard is an automated sequence of 
guided menus or windows that take you step-by-step through a process 
(in this case the creation of a chart). Position your cursor on a cell in the 

table or, for even more control, select the area that contains the data to be charted.  (Hint: 
you can select non-contiguous ranges by holding down the <Ctrl>-key when selecting non-
adjacent ranges!) 

First step of the Chart Wizard 

Click the Chart Wizard button on the standard toolbar (or select the Insert •Chart… 
menu option).  The first screen will allow you to choose an appropriate chart type and sub-
type. 

The major chart types are the following. 

Column and Bar chart: stress the differences between various data points. Best used for 
categorical data (e.g. regions, product types etc.) but also acceptable for time series. 

Line and Area chart: emphasise the trend displayed by the data.  Use for continuous data 
such as time series, growth curves and other evolutionary processes. 



Using Excel 2002  37 

Pie chart: shows the distribution of the data. The data series must add up to a total so that 
they can be expressed as a percentage. 

XY scatter: for (2-dimensional) data points 
with no intrinsic sequence but where there is a 
specific relationship between the independent 
and dependent variable. Unlike the previous 
charts, you can have data points with identical 
independent values. 

The Chart sub-type option allows you to refine 
your choice further. Usually the choice of sub-
type depends on the relationship between the 
various dimensions of your data; e.g. some 
data can be represented as a stacked column 
chart (if the values are additive) but other data 
types cannot. Be careful with three-
dimensional charts. Although they look more 
professional, they are often not so easy to 
read. On the other hand, they may enable you to visualise complex data much more easily. 

You can see a preview of how the chart (sub-)type will look for your own data by clicking and 
holding down the big View Sample button. When you are happy with your selection, click the 
Next > button. 

Step Two of the Chart Wizard 
This step allows you to select the orientation of the data. The Data Range tab allows you to 
indicate whether your data is organised horizontally (in rows) or in columns.  

This is also the step where you have more detailed control over each of your data series. 
Click the Series Tab to delete or add data series, change titles for the series or edit the 
ranges where the series values are to be found. 
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Remember that you can use the collapse icon to remove the window and keep only the text 
entry box visible for when you need to take a look at your spreadsheet (to check cell refer-
ences). 

Note that you may need to adjust the data range if your table includes column or row totals 
and you used the automatic range select prior to the invoking the graph wizard. 

Step Three of the Chart Wizard. 
Now that you have selected the type of chart and which data you want to chart, you are 
ready to fine-tune the exact formatting of the chart.  There are many options available and 
we shall briefly highlight some of them. 

 

If you are unsure about the meaning of any of the following terms, refer to the finished chart 
on the next page. 

• Titles: allows you to specify the title for the overall chart and label the various axes. 

• Axes: you can set the format of the various axes and whether labels should be shown. 

• Gridlines: specify whether grid lines show or not. 

• Legend: where the legend should be positioned (or omit it altogether). 

• Data labels: whether the actual values should be displayed next to the plotted data 
points (and where). 

• Data table: allows you to include a formatted table of the plotted data as part of the 
chart. 

Step Four of the Chart Wizard 
This final step controls where the chart should be placed in your document. 
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You can include it in your main worksheet (where it can be moved, resized and handled like 
any other embedded graphical object) or it can be put in its own separate chart sheet (no 
object formatting controls but easily accessible using the sheet tab). 

 

The various elements of a chart 
A chart has a number of elements, each of which can be formatted and positioned sepa-
rately. 

 

The quickest way to customise any chart element is by right-clicking it. Or click it and press 
<Ctrl>-<1> to open up the formatting window. It is sometimes a little tricky to right-click the 
correct chart element e.g. the text box instead of the text inside the text box, or a data point 
instead of the chart wall, etc. But a little practice makes perfect. 

You can also customise a chart by using the Chart Toolbar or the 
Chart menu options. The Chart menu replaces the Data menu when-
ever you are inside a chart. 

 

Data point 

Chart title 

Legend 

Plot area 
Grid line 
 

Value 
axis 

Category axis 

Category axis title 
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Further Graph Customisation 
It is possible to further customise your chart e.g. by inserting WordArt, AutoShapes and 
other objects. 

 

Creating a picture chart  
You can make bar and column charts much 
more attractive by creating a picture chart.  
Copy the picture you wish to use (from the 
clip art library or graphics application) to the 
clipboard (Edit • Copy or <Ctrl>-<C>), se-
lect the data series (or data point) in Excel 
and select the Edit • Paste option (or 
<Ctrl>-<V>) to paste the picture into your 
chart. 
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Grouping and Outlining Data Tables 
If you have a fairly large, hierarchically structured data set with varying levels of aggregation 
which you want to explore at different levels of detail, you may want to use the grouping and 
outlining feature of Excel. 

 

The table shown in the example, lists sales data 
horizontally across by month with subtotals for 
each quarter and the entire year. The rows rep-
resent individual stores, grouped by province.  

Often you are only interested in the aggregated 
sub-totals. Select Data  •  Group and Outline  
•  Auto Outline from the menu. Excel will now 
group the data at the same hierarchical levels 
based on the formulas used in the spreadsheet. 
Your spreadsheet will have collapse buttons 
next to the row / column names, which function 
similar to the folder collapse buttons in Explorer.  

 

Reveal Hide 

Hide all 
up to this 
level 

Lowest 
level 

Range  
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• Clicking on the  reveals the detail columns (or rows) for this sub-area. In the figure 
above, clicking the  button above the Q-column (where the cursor is currently posi-
tioned) will cause the columns containing the months of Q4 (the fourth quarter) i.e. col-
umns N, O and P (Oct – Nov) to be displayed.  

• Clicking on a  button hides the columns or rows as indicated by the associated bar: 

.  

• Clicking on the level number indicators  causes all corresponding data 
rows/columns to be collapsed or expanded simultaneously. E.g. click on the  to display 
the lowest level of detail (i.e. by month or store). Click on  to hide the lowest level and 
see only the quarterly or provincial subtotals. Clicking on  will display only the highest 
level i.e. the total for the year or the whole of South Africa. 

Since the the AutoOutline feature is based on the logic of the formulas used in your spread  
sheet, it may not always generate the correct levels. It is possible to 
manually adjust the grouping. Select a range containing the column or 
rows you wish to group (or ungroup) and click the Group (or Ungroup)  
menu option on the  Data  •  Group and Outline  menu (or the respective buttons on the 
toolbar if you’ve added the buttons.)  

Select the Rows or Columns option in the Group window and the 
rows or columns within the highlighted range will now be grouped 
accordingly. If you already had several levels of group/outline, a 
new level will be added. 
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Simple Data Analysis Using Data Functions 
Excel is often used to capture and process simple data contained in table format. Examples 
of simple data needs are address lists, pricing tables, sales transactions, and student marks. 
Indeed, a famous predecessor of Excel was called Lotus 1-2-3 with the “1” referring to the 
(financial) formula modelling capabilities, the “2” to its graphics capabilities and the “3” to its 
data capabilities.  

Data that can be stored in a single table is called “flat data” or “list data”, as opposed to 
more complex data as contained in hierarchical, network or relational format. Because a 
separate module deals with the use of Access for processing complex data, only a rudimen-
tary overview of the list data analysis capabilities of Excel will be given here. Generally, each 
row contains a “record” of data. For the examples listed above these would be (in respec-
tive order: a person, a product item, a sales transaction or a student. Columns would hold 
data attributes or fields. For the address list, fields could be first name, surname, telephone 
number, street address, birthday etc. For a pricing table, different columns would hold the 
product code, product name, product category, cost price, mark-up percentage and list sales 
price.  

It is suggested (and hereby assumed) that the first row of a data table, the header row, con-
tains the names (or descriptions) of the data fields. The row immediately below the header 
row should not be left blank but be filled with the data for the first record (item). It is bad 
practice to include any blank rows in a data table –they may cause the data analysis func-
tions to work in an unpredictable fashion. In particular, the first column of a data table should 
contain a continuous set of data all the way down to the last data record. Ideally, the first 
column contains an identifier which is unique to each row such as an ID number or even a 
row number. Conveniently, when you have calculated fields (fields which are based on other 
fields using a formula, e.g. Net Sales = Sales – Discount) in your table, Excel will automati-
cally copy them when entering (adding) a new line at the bottom of your data table. 

To illustrate the data analysis func-
tion, a table with 998 raw sales trans-
actions is used. The data fields are:  

• Transaction number (Xaction): a 
sequential number from 39283 to 
40280 

• Region: the regional area where 
the sales was made; a choice of 
WestCape, Gauteng, KwazuluN 
and NorthCape. 

• Product: which product item was 
sold i.e. Gizmos, Thingies, Wid-
gets or Gadgets. 

• Month: the month in which this 
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item was sold. 

• CustType: the type of customer (Corporate, Individual, Export or Wholesale). 

• Discount: the discount percentage applied to the sale (0, 10 or 25%). 

• Sales: the actual sales amount. 

Note that data assumed to be irrelevant for high-level data analysis, e.g. the customer name, 
day of the month or actual store was already filtered out. 

Sorting Data 
The most frequently used data tool is sorting 
data in some sort of alphabetical order. If your 
data is fully continuous, you can click anywhere 
within your table, else you should select the 
range of the entire table manually. 

Select the Sort… option on 
the Data menu and this will 
present you with the Sort dia-

logue window. You can choose up to three fields 
to sort your data with, with a different sorting or-
der for each: ascending i.e. from A • Z for text 
data or low to high for numbers; or descending 
i.e. high to low. If your data table contains a 
header row, you will be able to select the sorting 
key (i.e. the field) based on the field names; else 
you will be presented with the column names.  

If all you need is a quick, simple sort of your data table on just one particular field, you can 
just position your cursor in the field you want the table to be sorted on and click one of the 

appropriate toolbar buttons  for an ascending or descending sort respectively. For a 
multi-level or nested sort you need to select the Data • Sort option. In the example above, 
the entire table will first be sorted according to Product. The rows containing the same prod-
uct will be sub-sorted according to Region. The rows with the same product and region will 
then be sorted according to Month.  

Note that the month used here is a textual string, 
so the following order will be used: April < Feb < 
Jan < June < Mar < May! If a true date was used 
i.e. a date number formatted in a particular data 
number format, there would be no problem. The 
advanced options actually allow you to specify a 
non-normal sort (for the first key sort). In addi-
tion, you can also change the orientation of the 
sort (horizontal instead of vertical) and make the sort case sensitive, i.e. a < b < z < A < B. 
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Be warned: once data is sorted and the file has been saved, it cannot be unsorted again. 
Many data sets have become irreversibly corrupted by accidentally selecting only a few of 
the fields of the data set and sorting those fields whilst the unselected fields remained in the 
original order. In a large dataset, this often goes undetected until it is too late to undo… For 
this and other reasons, it is good practical to insert an extra column containing the original 
row order numbers. (In our example, this is not necessary because the transaction numbers 
can fulfil the same function since they are ordered and unique.) 

Automatically Creating Subtotals 
If your data contains a number of categories, you can create subtotals for each of your cate-
gories.  

The subtotal command assumes that you have sorted your data according to the category, 
e.g. if we want the monthly subtotal for each region and 
each product, then we would sort according to (1) re-
gion, (2) product and then (3) month as illustrated 
above. If monthly totals are required across all regions 
and products, then re-sort the data using the month as 
the first sort key. 

 To create (or remove) subtotals, select 
the Subtotals… option on the Data 
menu. This brings up the Subtotal dia-
logue window which allows you to spec-
ify the category for which you want to 
create subtotals (the table should have 

been sorted on this category), what mathematical func-
tion should be used to create the subtotal and for which fields you wish to create the subto-
tals. The Page break between groups option is especially useful for when you intend printing 
a report with each category on a separate page.  

Apart from the Sum-
function, you may find 
that you use the Count 
and Average functions 
also quite frequently for 
tallying the subtotals. 
Note also that Excel 
conveniently creates 
outline buttons allowing 
you to quickly switch 
between the detailed 
and the subtotal view. 
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Data Filter 
Another very useful and simple function for 
interactive data analysis is the Data  •  Fil-
ter  menu option. This allows you to display 
or hide selected rows, based on the value of 
one or several fields. The most commonly used filter with categorical data is the AutoFilter 
option.  

Clicking this option 
will create drop-down 
lists of filter-values 
for each of the fields. 
Click on any drop-
down list button to 
only display the de-
sired categories. E.g. 
in the example be-
low, only the sales 

for “Product = Thingies” and “Month = Jun” are being displayed (the list-button changes col-
our for those fields where a filter is active). The screen shows how an additional filter to se-
lect only the “Region = Gauteng” is being selected. Note that all filter selections are applied 
simultaneously (i.e. “and” instead of “or”).  

For more complex selections or for 
specifying criteria on non-categorical 
data (e.g. values), use the (Cus-
tom…) option on the drop down list. 
This allows you to specify more spe-
cific numerical filter criteria or to in-
clude wildcard characters (? or *) in 
text filters. 

To remove the 
autofilter drop-

down lists altogether, select the Data  •  Filter  • AutoFilter menu 
option again. Autofilter is a toggle option and the little tick indi-
cates whether the option is turn on (in effect) or off. 

The Advanced Filter… option on the Data • Filter menu is 
used to specify more complex criteria e.g. specific required value 
combinations of fields or multiple allowable values. One particu-
larly useful application of this is where a long list contains dupli-
cate records and you wish to create a (separate) subset contain-
ing only unique records. 
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Advanced Data Analysis using Pivot Tables 
What Are Pivot Tables? 
A more advanced way of doing data analysis is by means of pivot tables. This is an ex-
tremely powerful tool for interactive data exploration and data mining: looking for hidden 
relationships or patterns in large volumes of data. Again, it is most useful if you have a num-
ber of different categories or groups according to which data can be classified. Each cate-
gory (field) constitutes a potential dimension for analysis. In data mining your data set is 
called the data cube. If all your dimensions are numerical - continuous values - instead of 
categorical - a limited range of discrete values - you should use Excel’s statistical analysis 
tools instead e.g. multiple regression or ANOVA.  

The distinction between numerical and categorical data is quite important for pivot tables.  

• Numerical data consists of values, probably unique to each record. Examples are sales, 
costs, marks, scores and other values. This type of data can be totalled, averaged, and 
you can calculate the highest/lowest value, standard deviation etc.  

• Categorical data consists of a limited set of options. Examples are sales region (only a 
certain number of provinces), customer type (e.g. corporate, private or wholesale), prod-
uct group etc. These can be only tabulated (listed), usually in a sorted order, or the num-
ber of records within a given category can be counted.  

The pivot table will interactively tabulate subtotals (or other statistics) for a chosen numerical 
dimension (e.g. sales) according to any selected categorical dimensions (according to cus-
tomer type and sales region). It is basically an interactive, explorative, multi-dimensional, 
table-oriented and very flexible version of the subtotal function explained in a previous sub-
section. 

Although seemingly complex at first, Excel’s pivot table feature is actually not all that difficult 
to use thanks to the excellent pivot table wizard. Note that the exact use of the wizard and 
the pivot table feature has changed (improved) quite substantially in the last few Excel up-
grades, so if you are using an earlier version of Excel, some of the details may differ. If you 
are a student, your instructor may provide you with a good (i.e. relatively large) data set to 
practice with. We will illustrate the pivot table using the sales report example from the previ-
ous section. 

Using the Pivot Table Wizard 
To start, click anywhere on your 
dataset (again – we assume that it is 
a continuous dataset i.e. without 
blank columns or rows, and a proper 
header row indicating the field 
names). Select the PivotTable and 
PivotChart Report… option 
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 from the Data menu. This brings up the first step of the 
PivotTable Wizard which allows you to specify your source and required output. Your data 
source is most likely to be a Microsoft Excel list or database, although you may want to use 
an external (flat) database table accessible through the Office Data Connection. This is use-
ful if you have a very large set of data e.g. more than 65535 records (the maximum an Excel 
sheet can handle). The output report can be the PivotTable with or without the PivotChart. 

The second step of the PivotTable 
wizard allows you to specify the 
range of your dataset (the interface 
will be more complicated if you use 
a non-Excel source). If your dataset 
is in another spreadsheet, you can 

click the Browse… button to choose the source file. 

The last step of the wizard 
allows you to specify 
whether you want the report 
in a New or an Existing 
worksheet. It is preferable to 
put the report in a separate 
i.e. new worksheet.  

An additional option in this 
last step is the PivotTable 
Options…, which you are unlikely to change in your first few sessions. 

Another, more impor-
tant, option is to spec-
ify an initial layout for 
your pivot table.  Click 
the Layout…button to 
access the PivotTable 
Layout dialogue win-
dow. On the right-
hand side, you will 
see the list of your 
fields. In the middle 
you will find a blank 
pivot table report lay-
out.  

The easiest decision is what is the actual (numerical) data that you wish to analyse, should 
be. In this case, it is the actual sales figures. Drag the Sales button from the right and drop it 
into the DATA area of the pivot table report. Excel knows that it is numerical data and will 
assume that you want to analyse the Sum of Sales, i.e. subtotals. (You can change the type 
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of function easily enough in the report at a later stage). Next you need to select two initial 
categorical fields you want to use to construct your table, i.e. two dimensions which you sus-
pect of showing some pattern. In the example, we investigate to see if there is any special 
relationship between the type of customer (CustType) and the sales Region. Each button 
has been dragged across and dropped on the ROW and COLUMN area respectively.  

Using the Pivot Table 
Click OK to set your initial layout and click Finish to complete the last step of the pivot table 
wizard. The result will be a screen similar to the one below. 

 

Note the actual Pivot Table report, the pop-up task pane containing the field names, and the 
Pivot Table toolbar. Click the Format Report… option on the PivotTable 
menu on the PivotTable toolbar to apply an AutoFormat to your pivot table 
or apply your own formatting using the standard formatting options. (We 
will not go into detail on how to format the report.) 

We will also not endeavour to actually analyse any of the above data but 
of course, this is actually the purpose of the entire pivot table analysis. Generally, you should 
look for exceptionally large or small values, e.g. you can note that the lowest sales are the 
sales to individuals in the Kwazulu-Natal region. Also, the Northern Cape seems to be ex-
porting relatively more (because of its proximity to Namibia? Botswana?) than e.g. Kwazulu-
Natal or the Western Cape, despite the fact that its overall sales are lower! 

Assume that we want to do a more in-depth analysis of 
the sales in the Cape. Click on the drop down field 
name for the rows, Region, and deselect the Gauteng 
and KwazuluN boxes so that only the Northern and 
Western Cape remain. Click OK and a new table, a 
subset of the previous one will appear. We are inter-
ested particularly in comparing the Export and the 
Wholesale, since the sales for the other customer types 
appears to be normal. So deselect the Corporate and 
Individual options from the CustType dropdown list to have an even more reduced table. 

Pivot table report 

Pivot table toolbar 

Pivot table field 
list task pane 
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Let us now explore in more depth the remaining categories and bring in a third dimension. Is 
there any effect from the discount? Drag the Discount field button from the Field List task 
pane across to drop it on the column heading CustType, in cell A4 (or use the Add To button 
to add it to the Column Area). The pivot table will now include the Discount dimension.  

 

It is clear in the table that the Northern Cape has been promoting its exports by awarding big 
discounts (25%) while the Western Cape has been pushing its wholesale sales by awarding 

the 25% discounts. This can 
be visualised even better by 
swapping the Discount and 
the CustType buttons: drag 
the Discount button (B4) left 
and drop it on CustType 
(A4) to produce the differ-
ently organised pivot table 
below. 

 

 

 

The top row is generally used as a filter mechanism, by dropping Field Buttons in the top 
row. E.g. the Month field button was dragged from the task pane to row 1. Then the month of 
Mar was selected from the dropdown list button (in B1) in order to display only the sales for 
March. 
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For people who are more comfortable with a more visual approach, you should generate the 

Pivot Table Chart e.g. by clicking the Pivot Chart button on the toolbar. This chart has 
similar options and functions to the Pivot Table Report, but is often a lot easier to interpret. 
Below is the previous report as a 3-D chart (you may need to change the chart type to suit 

your style and data needs). Note how the Export-Wholesale 
reversal is highly visible in the chart area. 

There are many more exciting options. For instance, you may 
want to change the formula used to summarize the data. Use 

the pivot table Field Settings button  or menu option to e.g. 
display the average instead of the sum of the sales. You can 
even express them as % of subtotals (click on the Options 
button).  

In the end, the only real way to learn to use the pivot table 
feature is by practicing and exploring it.  
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Exercises 

Exercise 1 
Build the spreadsheet as requested below. 

Sheet 1 
This sheet compares the (fictional) airfares to popular destinations by a number of airlines. 

• Calculate the following: 

o Average fare = the average of the fares for each airline. 

o Rating = rating type for each airline based on their average fare, as per rating 
table (A11:C15) 

o Both a text and a graphical rating are given. The graphics are created using 
the Wingding font with the capital letters J, K & L. 

o Middle fare = the fare of the airline right in the middle of the range of fares 
e.g. BA’s fare to London falls inbetween (or is the median value between) 
SAA & KLM’s higher fares and AirEgypt & Virgin’s lower fares to London. 

o Range = difference between the highest (=maximum) and lowest airfare to 
each destination. 

• AutoFormat the table using the Colourful 1 format.  You may have to re-format row 1 and 
columns A, H. 

• Use a conditional format to show all the airfares above R5,000 automatically in italic bold  

• Headings in row 1 should be set to automatically wrap around if their length exceeds cell 
width, and are to be aligned to the top of the cells. 

• Cell A1 should have a diagonal line through it as per example (don’t worry about the text 
alignment). 
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Sheet 2  
Open Sheet2 in your workbook (i.e. in the same spreadsheet document) 

 

• Use AutoFill to fill the range A3:A102 with the consective days starting from 31-Aug-98. 

• Use AutoFill to fill the range B3:B102 with the cycle of the weekdays (excluding Wed) i.e. 
Mon, Tue, Thu, Fri, Mon, Tue, Thu, Fri, Mon etc. 

• Use a formula based on a built-in function to fill the range C3:C102 with random integer 
numbers from 0 to (but never equal to) 10 (no decimals).  The numbers should change 
each time the spreadsheet is updated. (2 marks!) 

• Ensure that all values in the range C3:C102 are displayed sideways (i.e. at an angle of 
90 degrees) and with a double underline.  

• In D2:N12, create a table that calculates the product of the numbers [11 to 20] and [5 to 
14] i.e. a “times” table as per example. You are required to use a formula that contains a 
mixed cell reference. (2 marks!) 

• Split the window vertically as per example. 

• Rename Sheet2 to Times and Sheet1 to Fares 

• Add a new sheet with the name NewSheet and move it so that it sits between Times and 
Sheet3. 

• Use the statistical built-in Excel formula to calculate the one-tailed probability of a value 
of 4.5 for the chi-square distribution. (5 degrees of freedom.) Answer:   . . . . . . . . . . . % 
(Note: give the answer in %) 
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Chart 
• Use the chart wizard to create a line chart representing the fares for each destination. 

• Use a  “Line-with-markers” chart 

• Use the data range, titles, axes labels as per example. 

• Give the chart the title Airfares which should have a bold border around it and be posi-
tioned on the left. 

• Ensure that the legend is on the left hand side 

• Put your chart on a separate Chart Sheet  with the name Graph. 

• Increase the titles, axes and legend fonts size to 14 or 16 points.  
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Exercise 2 
Build the spreadsheet as requested below. 

Sheet 1 
We are tracking the sales for 6 branches and 3 products.  Enter and format the data as per 
example below.  

• You should use the Excel built-in formulas to calculate the following: 

o Total (column E) = the sum total for the three models. 

o Budget = given (i.e. constants, no formulas) 

o Variance = the difference between total actual sales and the budget, ex-
pressed as a percentage of the budget. Note: this is the “accounting vari-
ance”, not the statistical one (i.e. don’t use Excel’s built-in var formula for 
this!) 

o Verdict = “Ok” if the variance is not negative, “Not Ok!” if the variance is nega-
tive. 

o Bonus = Bonus given for exceeding the budget.  The applicable incentive bo-
nus can be found in the “bonus” table A12:B15.  Where the budget has not 
been achieved (i.e. variance is negative), nothing should be given as bonus. 
(If you cannot do the later without modifying the bonus table, a “#NA” is fine). 

o Total (row 8) = total for all branches 

o Highest = highest value for all branches 

o Average = average value for all branches  

• AutoFormat the table using the list 3 format. 

• Assign the name Bonus to the range A12:B15 
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• The headings of the bonus table should be set to wrap. 

• The headings in row 1 should be at an angle of 45 degrees in 9 pt size. 

All values should be centered, left-aligned and formatted to the required precision as per ex-
ample. 

Sheet 2 

• Open Sheet2 in your workbook (i.e. in the same spreadsheet document) 

• Use AutoFill to fill the range A1:A50 with consecutive dates:  

• Use AutoFill to fill the range B1:B50 with the number sequence 1st, 2nd, 3rd, 4th, 5th etc. 

• Use AutoFill to fill the range C1:B50 with the sequence Jan,  , ... 

• Ensure that all values in the range B1:B50 are centered and double underlined. 

• In D2:J11, create a “divided by” table which divides the numbers 100 to 1400 by selected 
odd numbers as per example. You are required to use a formula that contains a mixed 
cell reference. 

• Split the window vertically. 

• Rename sheet2 to Divide 

• Save your spreadsheet again (overwrite the old copy when you are sure that your data is 
still ok.) 

• Delete sheet3 in your workbook. 
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Chart 

• Use the chart wizard to create a chart representing the sales for the three models and 
the five branches. 

• Use a  3-D Stacked Column chart 

• Use the data range, titles, axes labels as per example 

• The legend should be on the left. 

• Make sure that the actual (data) values are also shown in the columns 

• Create the chart on a new sheet with the name Sales Chart 

• Save your spreadsheet 
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Exercise 3 
Build the spreadsheet as requested below. 

Sheet 1 
We have a small class of four students.  

• Enter their names and marks for tests 1 to 3 as per example below.  The maximum score 
for each test is 10.  We award symbols as per the symbol table in A9:B15. 

• You should use the Excel built-in formulas to calculate the following: 

o Total = the sum total of the marks for tests 1 to 3 (i.e. out of a possible maxi-
mum of 30) 

o Final = the total expressed as a percentage and rounded to the nearest per-
cent. 

o Pass/Fail = Pass if the student obtains at least 50%, Fail if the student obtains 
less than 50% 

o Symbol = the appropriate symbol listed in the symbol table. 

o Average = average score for the class. 

o Highest = highest score obtained by any student in the class. 

• AutoFormat the table using the colorful 1 format. 

• Assign the name Symbols to the range A11:B15 

• Center the word Symbol Table across cells A9 and A10 

• The headings Less than and symbol in row 10 should be at an angle of 45 degrees in 8 
pt size. 

Save your spreadsheet. 
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Sheet 2 

• Open Sheet2 in your workbook (i.e. in the same spreadsheet document) 

• Use AutoFill to fill the range A1:A50 with the days of the week: Monday, Tuesday, ... 

• Use AutoFill to fill the range B1:B50 with the number sequence 15, 20, 25, 30, 35, 40,  ... 

• Use AutoFill to fill the range C1:B50 with the sequence Test 1, Test 2, Test 3, Test 4 , ... 

• Ensure that all values in the range B1:B50 are centered and double underlined. 

• In cell D13, use a built-in Excel formula to calculate the AVERAGE of the values in the 
range B1:B50. 

• In cell D14, use a built-in Excel formula to calculate the HIGHEST value in the range B10 
to B30 

• Format cells D13 and D14 so that the values are displayed in a FRAC-
TION format with tenths (one digit).  

• In D2:J11, create a “times” table for the numbers (5 to 10) x (5 to 13) as per example. 
You are required to use a formula that contains a mixed cell reference. 

• Format all columns so that their width is automatically set to fit the widest entry. 

• Split the window both horizontally and vertically. 

• Rename sheet2 to AutoFill 

• Save your spreadsheet again (overwrite the old copy when you are sure that your data is 
still ok.) 

• Delete sheet3 
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Chart 

• Use the chart wizard to create a chart representing the scores for the four students and 
the three tests. 

• Use a  3-D Column chart 

• Use the data range, titles, axes labels as per example 

• There is no need for a legend - remove it. 

• Give the chart the title 1998 Test Scores 

• Create the chart on a new sheet with the name Scores Chart 

• Save your spreadsheet 
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